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Welcome to CleverBOARD! After installing and setting up your CleverBOARD, use this guide to get up and running quickly.
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Your CleverBOARD combines the ultimate, high performance
whiteboard surface with award winning mimio® capture bar technology
and software, to provide a powerful collaboration tool that will change
the way you use a whiteboard. 

Capture your whiteboard notes & ideas
Brainstorming sessions, presentations, Classroom lectures.
Everything that you write, draw or erase on your CleverBOARD is
automatically captured to your PC without ever having to take notes! 

After a meeting or class, easily review, print, edit, e-mail and share
your whiteboard information with anyone, anywhere, anytime.

An instant electronic whiteboard
Transform your CleverBOARD into a fully interactive touch screen and
take control of your computer applications from the board itself,
simply by attaching a data projector to your computer and projecting
the desktop onto the board surface. 

Attach the mimio® directPrint™ add-on and CleverBOARD can also
be used as a copy board, with plain paper, colour copies from your
deskJet printer  - no PC required.  

Ultra high performance whiteboard surface with a lifetime guarantee
The CleverBOARD utilises the latest, high performance vitreous
enamel whiteboard  materials, which have unparalleled properties:
scratch resistant surface,  easy to clean, low glare surface for
superior results when used as a projection surface, Accepts
magnetic materials, so it can double as a display board.

Designed with security in mind
CleverBOARD’s built-in, lockable doors secures the electronics and
also the pens & eraser, thus eliminating unauthorised use, and
reducing the possibility of theft of CleverBOARD accessories. 

Full mim io ® compatibility
As CleverBOARD incorporates m im io ® technology, the full range of
mimio® software & hardware add-ons, accessories & spares can be
used. These are available from any m im io ® dealer and include,
m im io ® directPrint, m im io ® writingRecognition™ Software, as well
as replacement pen styli etc.

For details see www.m im io .com or www.europe.m im io .com . And
while you are there don’t forget to check out the latest m im io ®

software – including free upgrades.

about your
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Having successfully set up and installed your CleverBOARD following
the instructions in the ‘Easy Installation Guide’, this manual is designed
to help you get the most out of your CleverBOARD. Here you will find
all you need to know about the using the board itself, the software
and the other components. 

Help & Support
CleverBOARD Help: In the event of any question or problems arising
which are not covered by this guide, or the accompanying Quick
Start Installation Guide, please contact the CleverBOARD Help Line: 
020 8319 7788 or visit www.cleverboard.com

m im io ® software: Specific issues relating to the m im io ® software
are covered on page 11 – including details of m im io ® online and web
support.

about this guide
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The m im io ® software that accompanies the CleverBOARD saves
what you write, draw, and erase on your whiteboard and lets you
review your work. You can also use the m im io ® software for many
other useful features.

record CleverBOARD activity
No longer worry about someone erasing your whiteboard before you
have a chance to transcribe your notes! When you open the
m im io ® application and begin writing and erasing with the m im io
styli and the m im io eraser, your work is automatically captured on
your PC.

review a CleverBOARD session
The m im io application includes a playback option that allows you to
review your whiteboard session stroke by stroke, or one board at a
time. See “using playback features” on page 14    .

print boards
You can print any board, or series of boards, to any printer that is
accessible from your computer. See “printing boards” on page 14.

share boards
Share .ink files with other users of CleverBOARD and m im io ® (the
m im io ® software is a free download from www.m im io .com). See
“sharing .ink files” on page 14.

Export whiteboard information to a variety of file formats, such as JPEG,
Metafiles, Bitmaps and HTML. See “exporting boards as images” and
“exporting boards to HTML” on page 14.

Drag and drop whiteboard images into popular Windows applications.
See “drag and drop m im io ® content” on page 15.

tell me about the software
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mimioMouse - turns your CleverBOARD into a Windows
touchscreen!
Just project your Windows desktop onto the CleverBOARD and run
the mimioMouse® software.
After a simple calibration process you can use a mimio® stylus as a
mouse to control your PC from the whiteboard. See “using mimioMouse”
on page 17.

tell me about the software (contd)
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Load the mimio® software
Following the instructions in the “Quick Installation Guide”, you will
have already set up your CleverBOARD and connected the cable
from the socket in the left side base of the board to your computer. 

Now load the appropriate language version software CD in your CD
ROM drive, selecting the appropriate language disk. Upon insertion,
the setup programme starts automatically.  (If it does not, run the
setup.exe file on the CD). Then follow the screen instructions to
complete the installation of the software. 

Configure your CleverBOARD in the software
As the m im io ® software defaults to a 4’ by 6’ (1.2 m x 1.8 m) sized
whiteboard, you will need to adjust the settings to ensure the
software sees all of your CleverBOARD activity.

1 Open the Settings menu and choose <Page> (or click the <Page>
icon from the Settings Toolbar).

2 Click <Auto Size> and follow the on-screen instructions,
using the identification mark in the bottom right corner of the
CleverBOARD surface.

getting started
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You’ll find that using your m im io ® enabled CleverBOARD is exactly
like using a regular whiteboard. You’ll write, draw, and erase as usual,
but you use the special m im io ® styli and eraser to do it. You’ll also
want to use the features of the CleverBOARD and m im io ® software
to enhance your presentation.

writing with a mim io ® stylus
To write with a m im io ® stylus, press down on your whiteboard with
the marker tip to start a stroke, and lift the marker tip from the board
to end the stroke. You may need to apply a small amount of force to
activate the m im io ® capture feature.

Everything you draw on your whiteboard appears on your PC. If your
marker strokes do not appear on your PC, try holding the stylus more
perpendicular to the whiteboard as shown below, or try using slightly
more pressure.

When you finish using your stylus, be sure to cap it to prevent your
markers from drying out.

learning the basics

Incorrect

correct
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erasing with the mim io ® eraser
When you are working with the software you need to use the
m im io ® eraser in place of your regular whiteboard eraser. The
eraser has two eraser pads: a narrow eraser pad on the side of the
eraser, and a wide eraser pad on the base of the eraser.

To use the eraser, press either pad against the board and move it
over the areas you want to erase. You may need to use a small
amount of force to activate the capture feature. Anything that you
erase disappears from your PC. If your eraser strokes aren’t reflected
on your PC, be sure the eraser pad is pressed flat against the
whiteboard surface.

Incorrect

correct

learning the basics (contd)

wide eraser pad

narrow eraser pad
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New Board

Tag Board

LED

Print Board

Maximise Board

Control Panel

CleverBOARDTM us i ng  m im io ® techno l ogy

using the CleverBOARDTcontrols
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using the function buttons directly from your 

New Board
Adds a new blank board to your recorded whiteboard session (like
adding a new blank page). You need to erase your CleverBOARD
after you press this button.

Tag Board
Adds a tagged board to your recorded whiteboard session. A tagged
board is a new board with a copy of the previous board’s contents,
basically a new page where you can continue to make changes to
the contents of the previous page, while still saving that page as a
reference point. Kind of like a bookmark.

Print Board
Prints the current contents of your CleverBOARD. (This button will not
work if you do not have a printer installed and configured).

Maximize Board
Maximizes the m im io ® application on your PC, and makes it the active
application. Use this feature to call up the m im io ® application and verify
that the contents of your CleverBOARD are being recorded.

Control Panel
Begins the calibration process for the CleverBOARD control panel.

Place the control panel decal on your whiteboard and follow the on-
screen and audio cues for calibration. The CleverBOARD control panel
contains the talking calculator. Once you calibrate the control panel, you
can use a stylus to press any of the CleverBOARD control panel buttons.

understanding the capture bar LED

Off
There is a problem with the cable connection or the m im io ®

software has not been installed. Make sure your PC is turned on, the
software is installed, and that the cable is properly attached.

Solid Yellow
The CleverBOARD is receiving power, but it cannot communicate
with the m im io ® software. Make sure m im io ® is running and that
everything is connected.

Flashing Yellow
The CleverBOARD has failed its hardware self-test and will not
function. Contact your CleverBOARD dealer or call the CleverBOARD
Help Line on +44 (0)20 8319 7788, or www.cleverboard.com

Solid Green
The cable is connected and mimio® software is communicating with
the CleverBOARD. You are ready to begin.

using the CleverBOARDTcontrols (contd)
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.

using the mim io ® software

Capture Page
A view of the current

whiteboard that
you are writing to.

(Note: this feature is only available in
m im io ® software 2.0 and above.

Some language versions may be
supplied with m im io ® 1 x software

- to check, in the software, click
Help/About mimio®)

Styli and Eraser
Use the m im io ® software to draw

on the virtual whiteboard page

i) Single Board:
View the active
CleverBOARD session
ii) Player:
mimio® software plays back
the entire CleverBOARD
session - movie style - pause
- rewind etc
iii) Tabbed Views:
See above
iv) Full Screen:
View you CleverBOARD
session on your PC in full
screen mode

Tabbed Views
Pages tab - shows the boards in 

your current m im io ® session.
Notes tab - add notes to the

currently selected page.

Virtual whiteboard page
A view of your current

whiteboard.

Menu bar and Main Toolbar
Access m im io ®

software functions

m im io ® bar
Access General Pane,
Settings Pane,
Control Panels Pane,
and Plug-ins Pane.

(Note: Software may differ in appearance to that illustrated)
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creating new boards
To add a new blank board to your recorded whiteboard session:
Click New Page on the General toolbar or open the Edit menu and
choose New Page.
Note: You need to erase your whiteboard after you press this button.

adding tagged boards
To add a tagged board to your recorded whiteboard session:
Click Tag Page on the General toolbar or open the Edit menu and
choose Tag Page.
A tagged board is a new board with a copy of the previous board’s
contents, basically a new board where you can continue to make
changes to the contents of the previous board, while still saving that
board as a reference point.

adding notes to boards
To add notes to the currently selected board:
1. Click the Notes tab.  2. Type your notes. 

using the styli and eraser toolbar
The Styli and Eraser toolbar lets you use your mouse to draw and
erase on the virtual whiteboard. Use these tools to add to a m im io ®

session or to draw on the virtual whiteboard without attaching the
capture bar to your PC.

1 Select a marker or eraser to use

2 You can now draw and erase on your virtual whiteboard.
Click the cursor arrow to return to normal use.

saving boards 
When you press Save on the Main Toolbar or open the File menu and
choose Save, The m im io ® software saves your entire CleverBOARD
session in a single .ink file. This file contains:

• all marker and eraser strokes

• any notes that you’ve added

• session properties for all of the boards you worked on in
that session

Note: You can also use the Print functions to save CleverBOARD
data as an .eps file (CleverBOARD 2.1 software only). When printing,
select Save as File from the Printer options drop down menu and File
from the Destination drop down menu.

using the mim io ® software (contd)
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using playback features
mimio® sofware has VCR-like controls that let you play a
CleverBOARD session.

1 Press the playback view button.

The playback controls appear.

2 You can now use the controls to review your CleverBOARD session.

printing boards
You can print the contents of your CleverBOARD to any printer
accessible from your PC in one of three ways:

• Press the Print button on the capture bar, click Print on the General
toolbar, or open the File menu and choose Print.

sharing .ink files
mim io ® software saves your entire CleverBOARD  session in a
single m im io ® .ink file, which you can share with other CleverBOARD
or m im io ® users via e-mail or by posting on a web site.

Anyone can open and play .ink files using the m im io ® software, a
free download from www.m im io .com.

exporting boards as images
Follow these steps to export m im io ® boards as JPEG or Bitmap files.

1 Open the File menu and choose Export,
then choose image.

2 Select the boards you want to export as images and click Save.

3 Select the format
that you want.

exporting boards to HTML
Use m im io ® software to easily export presentations to HTML files.

1 Open the File menu and choose Export, then choose HTML.

2 Select the options you want for the HTML file you’re creating.

Note: When you export to HTML, m im io ® software saves your
CleverBOARD data as a JPEG file and creates an HTML file that points to
them.

using the mim io ® software (contd)
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drag and drop CleverBOARD content
You can drag your text or graphic into several popular Windows
applications, such as Adobe® Photoshop® or Microsoft Word®.

1 Use your mouse to select the part of the board that you want.

2 Drag your selection into an application.

copy and paste CleverBOARD content
You can also copy any information from your virtual whiteboard and
paste it into many PC applications. Select the information you want to
copy and paste it into a Windows® program.

using the mim io ® software (contd)

14-15
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using CleverBOARD control panels
You can operate the m im io ® calculator control panel from your
CleverBOARD using your m im io ® stylus. To use the control panel:

1 Peel off and attach the Calculator control panel decal to your
CleverBOARD.

2 Press the Control Panel button on the CleverBOARD controls
or click Control Panel on the General toolbar and follow the
on-screen instructions.

Once calibrated, you can press the “buttons” printed on the decal
with a stylus.

adjusting stylus settings
You can easily adjust the width of your marker strokes or change the
color associated with a stylus.

1 Open the Settings menu and choose Stylus Set or click the
Stylus Set icon from the Settings Toolbar.

2 Adjust the line width or color of a stylus as needed.

Note: You can apply your changes to the current board or to all boards
in the CleverBOARD session.

using the mim io ® software (contd)

Note: (This illustration is a for guide purposes only and may not match the pens supplied and/or the software screen shot.)
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mimioMouse® allows you to use a mimio stylus to provide mouse
input on a projected Windows desktop.

To use mimioMouse®:

1 Connect your CleverBOARD to your PC
2 Attach a projector to your PC and project your Windows desktop

onto the CleverBOARD surface.
Note: To properly calibrate mimioMouse, make sure the projected 
desktop is within the markers on the board surface.

3 Place the m im io ® pointer insert into one of your styli. The pointer
insert lets you click and drag on your projected Windows desktop
without leaving ink on your whiteboard.

Note: You can also use an old, dried out dry erase marker as your
mimioMouse insert.

4 In the m im io ® software, press the mimioMouse® icon in the
Plug-ins Pane. The mimioMouse® plug-in launches. 

5 Follow the on-screen calibration instructions as accurately as
possible (ideally, with the stylus at 90 degrees to the board when
touching down on the calibration point). 
Your stylus now becomes your mouse for the projected desktop. If
your mimioMouse® pointer seems out of synch with the desktop
(for instance, if you are having trouble clicking on objects or you
move your projector) re-run the calibration routine.

You can use mimioMouse® as a pointing device on the projected
desktop for all of the following tasks:

Left Click — Press the stylus against the projected desktop to click.

Right-Click — Press the Right-click mouse icon on the
mimioMouse toolbar, and then press the stylus against the
projected desktop to right-click.
or
Click and hold the stylus and then use the stylus against the
projected desktop to right-click. Note - Be careful to click in the
same spot on the desktop to activate the right-click. 

Double Click — Press the stylus against the projected desktop in
the same location twice within a second to double-click. 
Drag & Drop — Press and hold the stylus against the projected
desktop and move the stylus to drag a Windows object. Lift up the
stylus to drop object in its new location.

The mimioMouse® floating toolbar also includes a number of useful
tools for use in touch-screen mode. These include: 

Keyboard – for typing into applications
Mark-up, highlighting & annotation options – for adding impact to
PowerPoint® and other projected applications.
’Snap-shot’ button, which takes a ’snap-shot’ of any mark-ups you
make and saves them on your PC.  

using mim ioMouse®
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To learn more about the m im io ® software, or if you have difficulty
installing or using it, try looking at the m im io ® help or check out
www.m im io .com.

using mim io ® help
To get help for a particular window, press the Help button on the window.

To get help while using CleverBOARD with m im io ®:

1 Open the Help menu and choose m im io ® Help.

2 Type a word and click Search or click on a topic to browse the help.

getting web support
Visit the m im io ® web site for online support and product updates.

1 Open the Help menu and choose Web Support.

2 Choose from product support, FAQs, and software updates.

learning more about mim io ® software
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how do I share my CleverBOARD presentation?
Send a saved .ink file to other users of CleverBOARD or m im io ®.
The m im io ® software is a free download from www.m im io .com.

Export CleverBOARD data as JPEG or Bitmap images. See
“exporting boards as images” on page 14.

Export a CleverBOARD presentation to HTML. See “exporting boards
to HTML” on page 14.

can I copy CleverBOARD data into other applications?
Yes! You can quickly and easily copy and paste or drag and drop
m im io ® content into several popular Windows applications, like word
processing and graphics applications. See “drag and drop CleverBOARD
content” and “copy and paste CleverBOARD content” on page 15.

how come some of my marker and eraser strokes are not
reflected on my PC?
You may need to make some adjustments to your whiteboard technique.
See “writing with a m im io stylus” on page 8 and “erasing with the
m im io eraser” on page 9.

how do I edit my CleverBOARD notes?
Once you record a whiteboard session and save it, simply reopen
the .ink file and add new information to it.

how are the marker and eraser buttons in the toolbar used?
The m im io ® software contains a styli and eraser toolbar that lets you use
your mouse to draw on the virtual whiteboard in the software. See “using
the styli and eraser toolbar” on page 13.

what are the VCR-like controls for in the player view?
These controls are for playing back a whiteboard session. See “using
playback features” on page 14.

how do I find notes that I forgot to tag?
You can easily find any point in your CleverBOARD session by using the
Tabbed View toolbar. Use the player controls to find the desired information.
Once you locate the information you can insert a tag so it is readily available
the next time you review the recorded CleverBOARD session.

when i save an .ink file,am I saving a single image or the
entire session?
The save feature saves the entire whiteboard session in a single .ink
file, including all marker and eraser strokes, notes, and session
properties for all boards included in the session.

how come I can ’t see all of the CleverBOARD on my PC?
You need to configure the software to match your CleverBOARD.
See  “Configure your CleverBOARD in the software” on page 7.

answering common questions
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why is there so much white space on my whiteboard?
Same answer as above,

how do I use auto-saving?
mim io ® software can save your whiteboard session at regular time
intervals. To turn on or off auto-saving, select Options from the Settings
menu. When you turn on auto-saving, the m im io ® application
automatically assigns a name to auto-saved files that includes the date
and time the session file was created. See the m im io ® online help for
more information.

how do I make the whiteboard ink thinner on my PC?
If the whiteboard text captured on your PC display is too dense or
difficult to read, you can adjust the width of the marker strokes on the
display. Select Stylus Set from the Settings menu. See “adjusting
stylus settings” on page 16.

can I open and share .ink files with users of the Macintosh®

version of the CleverBOARD software?
Yes. You need to save your m im io ® files with a .ink extension, and
then you can send your .ink files to Macintosh users.

the serial cable supplied with CleverBOARD doesn’t reach my
PC, is there an extension?
Yes. Serial extension cables are available from CleverBOARD and
m im io ® dealers (see page 3) or computer dealers.

answering common questions (contd)
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© Copyright 1999-2001 Virtual Ink Corporation, all rights reserved.
CleverBOARD is a registered trademark of Sahara Presentation
Systems.
m im io ®, mimioMouse®, mimio directPrint®,
mimio writingRecognition® and Virtual Ink are registered trademarks
of Virtual Ink Corporation.

Macintosh is a registered trademark of Apple Computer, Inc.
Windows, Netmeeting and Microsoft are registered trademarks of
Microsoft Corporation. Adobe and Photoshop are registered
trademarks of Adobe Systems Incorporated. Expo is a registered
trademark of Sanford Corporation. All other marks are trade-marks or
registered trademarks of their respective holders.

U.S. Patent Nos. 6,147,681, 6,124,847, 6,111,565, 6,104,387,
6,100,877, 6,177,927, 6,191,778, 6,211,863, 6,217,686, 6,232,962.

U.K. Patent Nos. 2,340,712B, 2,340,632B, 2,340,606B, 2,337,330B,
2,340,605B, 2,349,449B 2,340,449B. Other Patents Pending.
Warning! - Each of the m im io ® styli and eraser uses one (1) AAA
size 1.5 VDC alkaline battery type E902-LR03AM4. The battery
terminals + & - are clearly identified on the battery and on the product.

Warning! – This product contains alkaline batteries.
(1) Battery - keep away from small children. If swallowed, promptly
see a doctor. Have the doctor phone the nearest poison control
centre (in US (202)625-3333 collect or dial 911 and ask for the
nearest poison control centre).
(2) Battery - Do not open, dispose of in fire, recharge, put in
backwards, mix used & unused batteries, mix with other types of
batteries — may explode or leak and cause personal injury.

copyright and legal information
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Manufacturer’s Name: Sahara Presentation Systems plc

Manufacturer’s Address:
Williams House, Hailey Road, Erith, Kent, DA18 4AA, United Kingdom

Declares that the product:
Product Name: CleverBOARDTM

Model Number: applied for

Conforms to the following standards:
Safety: EN 60950:2000 +A1:1993 +A2:1993 +A3:1995
+A4:1997 +A11:1997 EN 60825-1:1994

EMC: EN 50081-1:1997, EN 55022, Class B (CISPR-22)

Immunity: EN 50082-1:1997 EN 50024, using:
EN 61000-4-2:1995 (IEC 801-2),EN 61000-4-3:1996 (IEC 801-3),
EN 61000-4-4:1995 (IEC 801-4),EN 61000-4-5:1993,
EN 61000-4-6:1994, EN 61000-4-11:1994,EN V 50204:1996

The product is in conformity with the requirements of the General
Product Safety Directive (92/59/EEC), the Low-Voltage Directive
(73/23/EEC), the EMC Directive (89/336/EEC and Amendment
92/31/EEC), the Machinery Directive (89/392/EEC), and the Product
Liability Directive (85/374/EEC-1999/44/EEC).

Declaration of Conformity
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You may freely distribute this software subject to this software
license agreement.

This is a legal agreement between you, the user (“Licensee”) and Virtual
Ink Corporation (“Virtual Ink”) regarding the software program attached to
or enclosed or otherwise associated with this software license agreement
(the “SOFTWARE”). By agreeing to these license terms as presented
during software installation, by opening the packaging of the
SOFTWARE, or by installing or using the SOFTWARE, Licensee agrees
to be bound by the terms of this Software License Agreement (the
“Agreement”). If Licensee does not agree to the terms of this Agreement,
then you must terminate the download or install process, and (if you have
a copy) return the SOFTWARE and any accompanying items to the
place from which you obtained them for a refund.

License. Virtual Ink grants to Licensee a non-exclusive license
provided under this Agreement expressly limited to (1) use of the
enclosed SOFTWARE in combination with an authorized MIMIO®
system including a MIMIO® capture bar and one or more MIMIO®
styluses and erasers, and (2) use of the SOFTWARE to manipulate,
change, edit, or otherwise alter files formed with an authorized
MIMIO® system including a MIMIO® capture bar and one or more
MIMIO® styluses and erasers.

The non-exclusive license provided under this Agreement expressly
excludes (1) use of the enclosed SOFTWARE with any capture bars,
styluses, or erasers which have not been expressly authorized by
VIRTUAL INK and (2) use of the enclosed SOFTWARE to manipulate,

change, edit, or otherwise alter files formed with any capture bars,
styluses, or erasers which have not been expressly authorized by
VIRTUAL INK, and (3) any other license rights not otherwise expressly
granted under this Agreement.

Copy Restrictions. This SOFTWARE and documentation is protected by
United States copyright laws and international treaty provisions.
Unauthorised copying of the SOFTWARE in whole or in part is expressly
forbidden. Subject to these restrictions, Licensee may (i) load the
SOFTWARE onto one computer to support authorized use, (ii) make one
copy of the SOFTWARE solely for backup purposes, provided Licensee
includes all copyright and trademark notices on the back-up copy, (iii) make
copies to distribute to others, provided that (a) this license agreement and
any supporting files or data are not removed from the SOFTWARE or
disabled, (b) the copies are distributed free of charge, and (c) the copies
are not distributed over a public network including the Internet. Licensee
may not copy any part of the documentation, nor modify, adapt, translate
into any language, or create derivative works based on the documentation
without the prior written consent of Virtual Ink.

Ownership of the SOFTWARE. Virtual Ink retains all right, title, and
interest in the SOFTWARE and documentation (and any copy thereof),
and reserves all rights not expressly granted to Licensee. This
Agreement transfers to Licensee neither title nor any proprietary or
intellectual property rights to any of the SOFTWARE or documentation,
or any copyrights, patents, or trademarks, embodied or used in
connection therewith, except for the rights expressly granted herein.
This Agreement is not a sale of the original SOFTWARE or of any copy.

Software License
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1

Sahara Presentation Systems PLC
Williams House, Hailey Road, Erith Kent DA18 4AA England 
www.cleverboard.com

mimio is a registered trademark of Virtual Ink Corporation.
CleverBOARD is a registered trademark of Sahara Presentation Systems PLC.
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